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Safety information
Thank you for selecting the 905U-L for your telemetry needs. We trust it will give you many years of valuable service. To
ensure your 905U-L enjoys a long life, double-check ALL your connections with the Installation Guide before powering
on the module.
WARNING: Incorrect termination of supply wires may cause internal damage and will void warranty.
Exposure to RF energy is an important safety consideration. The FCC has adopted a safety standard for human exposure
to radio frequency electromagnetic energy emitted by FCC regulated equipment as a result of its actions in Docket 93-62
and OET Bulletin 65 Edition 97-01.

FCC Notice when used in USA: 905U Wireless I/O Module
Part

Additional information

15

This device has been tested and found to comply with the limits for a Class B digital device, pursuant to Part15
of the FCC rules (Code of Federal Regulations 47CFR Part 15). Operation is subject to the condition that this
device does not cause harmful interference.

90

This device has been type accepted for operation by the FCC in accordance with Part90 of the FCC rules
(47CFR Part 90). See the label on the module for the specific FCC ID and any other certification designations.

Industry Canada: 905U Wireless I/O Module
RSS-119 - This device has been type accepted for operation by Industry Canada in accordance with RSS-119 of the
Industry Canada rules. See the label on the module for the specific Industry Canada certification number and any other
certification designations.
NOTE: Any changes or modifications not expressly approved by ELPRO Technologies P/L could void the user’s authority
to operate this equipment.
To operate this equipment legally the user must obtain a radio-operating license from the government agency. This is
done so the government can coordinate radio users in order to minimize interference.

Safety information - FCC Notice
This device complies with Part 15.247 of the FCC Rules. Operation is subject to the following two conditions:


This device may not cause harmful interference; and



This device must accept any interference received, including interference that may cause undesired operation

NOTE: This equipment is suitable for use in Class 1 Division 2 groups A, B and C or non-hazardous locations only.

**IMPORTANT ELECTRICAL SAFETY INFORMATION**
In order to comply with Electrical Safety Regulations, this module must be installed in an Electrical AND
Fire enclosure. This enclosure may be a single or multiple enclosures. Access to the module is to be made
by a Service Person only.

UL Notice:
1. The Wireless I/O module is to be installed by trained personnel / licensed electricians only and installation
must be carried out in accordance with the instructions listed in the Installation Guide and applicable local
regulatory codes.

2. The units are intended for Restricted Access Locations.
3. The Wireless I/O module is intended to be installed in a final enclosure, rated IP54, before use outdoors.
4. The Equipment shall be powered using an external Listed Power Supply with LPS outputs or a Class 2 Power
Supply.

5. The Wireless I/O module must be properly grounded for surge protection before use.
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What’s in this document
This document is the 105U-L Wireless I/O Configuration Manual that describes how to
install and use the 905U-L.
This document contains the following sections:
If you want to …

Description

For more information,
see …

Understand how 905U-L
works

Explains how 905U-L works and provides
information about the main features of 905U-L.

Introduction to 905U-L
on page 9.

Understand the basic
steps for configuring
905U-L

Lets you understand the tasks to perform to install
905U-L.

Introduction to
configuring your unit on
page 14.

Learn how to use the
configuration software

Lets you start and close the configuration software
as well as checking the current version of the
software.

Using the configuration
software on page 18.

Learn how to work with
projects.

Lets you open, update and close projects used for
storing information for your system.

Working with projects
on page 21.

Learn how to configure
individual units

Lets you create, update and delete units.

Working with units on
page 43.

Learn how to set unit
mappings.

Lets you set information for specific units.

Sending data to another
station using mappings
on page 62.

Learn how to set and
configure thermocouple
tables

Lets you measure millivolt signals (-10 – 100 mV)
and thermocouple signals with cold junction
compensation.

Working with
thermocouple tables on
page 76.

Print information about
your system

Lets you view a summary of your system information
and optionally print the information.

Printing on page 87.

Use the supporting
utilities

Provide one-step access to help speed up common
tasks such as compiling the system and packing the
database.

Utilities on page 88.

Fix problems with your
unit

Lets you identify and fix problems with your unit.

Troubleshooting on
page 100.

Understand the meaning
of a term

Lets you understand the meanings for terms used in
this document.

Glossary on page 106.

For more information on installing your 905U-L, please see the 905U-L Installation Guide
and the 905U-L Quickstart Guide.
For more information, see the next sections.
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Document conventions
This document uses different fonts to indicate specific information.
Bold indicates a menu option that you can select, or a button/icon that you can click to
activate.
Double quotes (““) indicate a cross-reference to another section in the document. For
example, see “Document conventions” on page 8.
Bold italic indicates a reference to another different document. For example, the 905U-L
Installation Manual.

Note
Indicates important information you should know.

Warning
Indicates important information that you should know and often relate to safety issues.

In this document, shortcut keys appear as Ctrl+P. This means you should hold down the Ctrl
key and then click the P key.
In this document, menu selections appear as File » Exit. This means that from the File menu,
you should select the Exit option.
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Introduction to 905U-L
The 905U-L product provides economical standard “off the shelf” wireless I/O (i.e. transmitting
signals over long distances via radio).
The 905U-L can monitor and control the following types of signals:
Signal

Examples

Digital on/off signals

Outputs such as motor run, siren on, etc.
Inputs such as motor fault, tank overflow, intruder alarm, etc.

Analog continuously variable signals
(0-20mA)

Outputs such as tank level indication required motor speed, etc.

Millivolt signals and thermocouple
signals

Measurement of temperature using thermocouples, including
cold junction compensation.

Pulse count signals

Electricity metering, fluid flow, etc.

Internal status signals

Analog supply voltage, power status, solar panel status and low
supply status, etc.

Inputs such as measured tank level, actual motor speed, etc.

The 905U-LT monitors input signals and transmits the information to one or more receiver
modules. The receiver module(s) reproduce the signals as digital, analog or pulsed output
signals. You can also use setpoints to turn digital outputs on or off based on the level of an
analog input.
ELPRO wireless gateway units can act as receiver modules and pass the transmitted signals
from the 905U-LT to an external data bus (e.g. Modbus, Profibus, Ethernet, etc.).
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Key features
Feature

Description

For more information, see …

Mappings

Lets you configure which inputs are sent to which outputs.
Mappings can be triggered on a change of state (event
reporting) or on a timed basis (periodic update).

Sending data to another station
using mappings on page 62

Outputs can be physical outputs or Gateway registers.

Discrete signals

Lets you monitor discrete (on or off) signals such as level
switches and alarms.
The 905U-LT has two discrete inputs. The 905U-LR has
three discrete relay outputs

Analog signals

Lets you monitor 4-20 mA and 0-20 mA current loop
signals.

Setting unit sensitivities on page
70

The 905U-LT has one 0-20 mA analog input. The 905U-LR
has one 0-20 mA analog output
Millivolt signals
(Thermocouple)

Lets you measure millivolt signals (-10 – 100 mV) and
thermocouple signals with linearization for several different
types of thermocouple and cold junction compensation.

Working with thermocouple tables
on page 76 and Working with units
on page 43.

The 905U-LT has one millivolt input that you can use for
thermocouple input with or without cold junction
compensation.

Pulsed signals

Lets you count the number of times an input turns off and
on, for example monitor pulses from a flow meter

Counting events by setting unit
pulsed inputs on page 71.

Setpoints

Lets you control a remote digital output depending on the
value of an analogue input compared to user-configured
setpoint values.

Setting setpoints on page 73.

The 905U-LT supports:

• Standard (fixed) setpoints; and
• Rotary setpoints – that determines threshold values
using the position of the rotary switch on the module.
System Status

Lets you activate an alarm if the internal self-monitoring
system indicates a problem, or if the module loses power

905U-L Installation Guide.

Communication
Status

Lets you activate an alarm if the module hasn’t received any
communication for a certain amount of time

Handling communication failures
by setting output reset times on
page 86

Debounce

Lets you set the amount of time an input needs to have
differed from its previous value before it is recognised as
having changed. This helps with noisy signals.

Sensitivities

Lets you set the amount of change required of an input
before the 905U-LT identifies the value as different from its
previous value.

Setting unit sensitivities on page
70

Unit details

Lets you create and update units and set unit-specific
information.

Working with units on page 43.

For more information, see the next sections.
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Operation
The 905U-L family of modules includes both a transmitter (905U-LT) and a receiver (905ULR). You can:





Send signals from the transmitter to the receiver;
Send signals from the transmitter to other ELPRO 105 modules; and
Send signals from other ELPRO 105 modules to the receiver.

The transmitter and receiver include a default function to work as a pair by sending signals
from the transmitter to the receiver with the most commonly used inputs of the transmitter
being mapped to the outputs of the receiver. You can restore the default function at any time
by “linking” the receiver to the transmitter.
You can create more complex configurations using the E-Config software, including sending
signals via repeater stations and sending signals to other ELPRO 105 modules.
For configuration both modules have an RS232 RJ-45 connector on the front panel for
configuration that you can use in conjunction with the serial configuration cable supplied by
ELPRO.
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Transmitter (905U-LT)
The transmitter monitors inputs for changes, and forwards information about the state of the
inputs to other modules based on the mapping configuration.
Mappings define when to send information about the inputs to remote modules. Mappings
can be triggered by a change of value of one of the inputs or after a specified time has
elapsed since the last transmission of the information.
The transmitter provides:




Physical inputs - the discrete, analog and thermocouple signals; and
Virtual or internal inputs - - derived from the physical inputs (e.g.. setpoint inputs and
pulsed inputs).

Setpoint status
Setpoint status “inputs” are derived from analog inputs using high and low threshold levels.
Setpoint status turns “on” as the analog signal moves below the low threshold and “off” above
the high threshold. Between the low and high setpoints, the setpoint status remains
unchanged.
A rotary switch on the front of the transmitter unit lets you select between ten sets of userdefined setpoint thresholds.
Pulsed inputs
Pulsed inputs create “count” registers derived from the discrete inputs. The 905U-LT counts
the number of pulses on each pulsed input and stores the count in a count register. Each time
the discrete signal changes from off to on, the pulsed input register increments by one count.
The front panel LEDs indicate the state of the discrete inputs as well as the setpoint inputs.
The transmitter also controls two physical outputs:




Setpoint output – that indicates the status of the virtual setpoint input; and
Module OK output – that becomes active when the module’s system status indicates
there are no problems in operation.

You can also configure the module to:



Increase reliability – by sending messages multiple times. ELPRO testing indicates
three times gives best reliability in most systems); and



Increase message distance – by including one or more repeater stations in the
mapping.

When the module sends a message, the yellow LED on the front panel flashes.
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Receiver (905U-LR)
The receiver receives messages and updates its outputs according to the radio messages.
When the module receives a radio message, the yellow LED on the front panel flashes.
The receiver provides one analog output (4-20 mA), and three discrete relay outputs. The
receiver also provides two status outputs, indicating module OK and communication failure.
Module OK output
The module OK output remains on while the module is running and its system status
indicates the system is working correctly. The LED marked OK on the front panel is green
when the system is working correctly and red otherwise.
Communication failure output
The communication failure output turns on when the 905U-LR receiver does not receive a
message within a user-configured time. Each output has a “comms-fail” timer that resets
each time it receives a radio message for the output. If the timer associated with any of the
outputs reaches the configured timeout value (i.e. indicating no message was received in the
user-configured time) the communications failure output is set on. The LED on the front panel
marked CF also indicates a communication failure.
Front panel indicators
Each output has an indication LED on the front panel of the module indicating the status of
the output. Each of the three discrete outputs also has an associated green LED that turns on
when the output is on. The analog output has an associated red LED (marked AZ) that turns
on when the analog signal is zero.
The receiver sets each output according to the value specified in the messages it receives.
The unit also records the time of the most recent received message that addresses each
output. If no message is received within the configured timeout for the output, the receiver
indicates a communications failure for the output. When an output is in communications
failure, the associated LED flashes quickly and the module communication failure output turns
on to indicate a fault. The LED associated with the analog output for the purposes of
indicating communication failure is marked PG on the front panel.
The receiver also records the signal strength of messages it receives. Pressing the button on
the front panel of the receiver causes the LEDs to light up showing a bar graph of the signal
strength of the last received message; red indicates poor signal, yellow indicates marginal
signal, and green indicates a good signal.
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Introduction to configuring your unit
This section describes how to configure your 905U-L.

Note
For more information on installing your 905U-L, please see the 905U-L Installation Guide.

You can configure your network using:



User-defined (customized) configuration – that lets you set specific information
about your network and allows communication with other ELPRO 105 modules.



Default factory configuration – that lets you use a transmitter and receiver as a
simple send/receive pair.

This manual describes how to perform custom configuration to:




Fully utilize of the features of the 905U-L modules; and
Communicate between 905U-L modules and other ELPRO 105 modules.

For more information on restoring the default configuration (i.e. linking), refer to the Quick
Start Guide included with your module.
The following tables detail the default settings:
Setting

Default

Periodic transmission

Every second

Analog sample rate

5 samples per second

Analog change of state sensitivity

3%

Output state on comms failure

Reset to zero

Analog setpoints

Set by rotary switch (switch value x 10%±5%)

Analog Input debounce

1 sample

Digital input debounce time

0.5 seconds

Signals sent over radio
905U-LT(Transmitter)

Sends

905U-LR (Receiver)

Digital Input 1



Digital Output 1

Digital Input 2



Digital Output 2

Analog Setpoint



Digital Output 3

Analog input (4-20 mA)



Analog output

905U-L Wireless I/O
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Other signals
905U-LT(Transmitter)

905U-LR (Receiver)

Thermocouple Input (Not used)

Communication Failure
(All timeouts set to 10 seconds)

Setpoint Output (Local indication)
System OK (On if system OK)

905U-L Wireless I/O
Version 1.4

System OK (On if system OK)

page 15 of 108

ELPRO Technologies

905U-L Wireless I/O Configuration Manual

Basic steps for configuring your unit
The basic steps for configuring your 905U-L are:
1. Install the E-Config Software program on your PC.

Note
E-Config can also configure other ELPRO units. For more information on other ELPRO
units, please see the product documentation.

2. Connect your 905U-L unit to the PC using the RS-232 serial cable.
3. Configure your 905U-L as required using the following steps:
Step

Description

For more information,
see …

1. Set the system
information

Each module requires a:

Setting the unit address
on page 54.

•

•

System address – common to all modules in
the same system. The 905U-L uses the system
address to prevent “cross-talk” between
modules in different systems; and
Unique unit address – that uniquely identifies
the module in a system.

2. Configure the
individual units

Lets you select the individual units, modify unit
addresses and set the properties for each unit.

Working with units on
page 43.

3. Compile the system

Lets you check your system configuration, report any
errors and generate configuration files for each unit.

Compiling the system
on page 90.

4. Load the configuration
information into the
module

Lets you transfer the configuration information to a
module.

Loading configuration
information into a unit
on page 93.

5. Test the system

Let you test the system (including all modules) to
help easily identify any problems.
We recommend you bench test the complete system
before installing a new system.
Configuration problems are easier to identify and fix
when the modules are nearby.

For more information, see the next sections.
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Hardware and software requirements
E-Config requires the following minimum PC configuration:
Setting

Additional information

Operating system

Windows 98 or later

Processor

Pentium or greater

Memory

Minimum 128 Mb

Disk space

5 Mb for E-Config
17 Mb during installation
1M (approximately) for each project

Serial port

1 serial port

RS232 serial cable

EIA-561 (RJ45) to EIA-574 (DB9)
ELPRO provided serial cable.
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Using the configuration software
Note
This document refers to the E-Series Configuration software as E-Config.

E-Config lets you configure units using a configuration software program. The configuration
software runs as a Windows application on a PC and lets you:



Create a configuration file – that contains specific information for all units in the
system including 905U-L units;




View and change the configuration information – as required;



Load the configuration information – from each of the 905U-L modules via the RS232 cable into the configuration file.

Program the configuration information – to each of the 905U-L modules via the RS232 cable; and

E-Config lets you:
Task

Description

For more information,
see …

Installing the
configuration software

To configure your modules, you must install the EConfig software.

Installing the
configuration software
on page 19.

Start E-Config

Lets you work with your module to communicate and
transfer information between the module and your PC.

Starting E-Config on
page 19.

Exit E-Config

Lets you close the software for communicating and
transferring information between the module and your
PC.

Exiting E-Config on
page 20.

Check your
configuration software
version

Lets you identify the current version of software in use.
This information is important for contacting ELPRO if
you have support issues.

Checking the current
configuration software
version on page 20.

For more information, see the next sections.
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Installing the configuration software
To change the configuration of your module you must install the E-Config software.
To install the E-Config software:
1. Insert the CD.
2. Run setup.exe.
3. The installation wizard will guide you through the installation process.

Starting E-Config
E-Config lets you configure an entire communication network, and lets you work with your
module to communicate and transfer information between the module and your PC.
To start E-Config:
1. Select Start » All Programs » Eseries » Eseries.

Note
You can also start E-Config by navigating to the Configuration Menu or running
ESERIES.EXE in the directory selected during the software installation.

2. E-Config automatically starts:

3. You can now start configuring a system.

905U-L Wireless I/O
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Exiting E-Config
Exiting E-Config lets you close the software for communicating and transferring information
between the unit and your PC.
To exit E-Config:
1. Select File » Exit.
2. E-Config automatically exits.

Checking the current configuration software version
Information about the version of software running on your PC is important for contacting
ELPRO if you have support issues.
To check the current software version:
1. Select Help » About.
2. E-Config shows the software version information:

3. Click OK to close the software version information.
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Working with projects
E-Config lets you create a “project” that stores information for your “system”. Each project can
contain one or more units that correspond to a hardware module. Each unit has specific
settings and information as shown in the following table:
Information

Example

Project and units

Individual units

Module (i.e. unit-specific)
information

As you build the configuration, E-Config automatically saves the information in the Project
directory. The project directory contains the configuration files for all modules in the system.
E-Config lets you:
Task

Description

For more information, see …

Create a new project

Lets you create a new project.

Creating new projects on page 22.

Open the last opened project

Lets you open the last opened
project.

Re-opening the last project on page
24.

Open any project

Lets you open any project.

Opening any project on page 25.

Showing project information

Lets you view information about the
project.

Showing project information on page
26.

Set project information

Lets you set information about your
project including the project name,
location, etc.

Setting project information on page
28.

Backup a project

Lets you store a project on your
PC.

Backing up projects on page 39.

Restore a project

Lets you recover a project stored
on your PC.

Restoring projects on page 41.

For more information, see the next sections.
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Creating new projects
E-Config lets you create new projects.
To create a new project:
1. Click Open New Project

or select File » New Project:

Note
If you are already working with an open project, E-Config confirms you want to close the
currently open project:

Click Yes to close the open project or click No to return to the current project.

2. Enter the name of the project you want to create and the directory where you want to
create the project:

Note
A directory can only contain a single project.

3. Click OK to create the project or click Cancel to return to the previous screen without
creating a new project.
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4. E-Config confirms that you want to create the new directory:

5. Click OK to create the new project or click Cancel return to the previous screen without
creating a new project.
6. E-Config creates the new project and opens the project:

7. You can now start configuring the project / system.
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Re-opening the last project
E-Config lets you open the last opened project. You can alternatively open any existing
project. For more information, see Opening any project on page 25.
To re-open the last project:
1. If you have opened a project, E-Config shows the project name on the startup screen:

2. Click Re-open Previous Project

.

3. E-Config automatically opens the previous project

4. You can now start configuring the system.
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Opening any project
E-Config lets you open any project. You can also open the last opened project. For more
information, see Re-opening the last project on page 24.
To open any project:
1. Click Open Existing Project

or select File » Open Project.

2. Navigate to the directory that holds the project you want to open. If you double click the
directory in the browse window, E-Config automatically fills in the project name.
Alternately enter the name of the project you want to open:

3. Click OK to open the project or click Cancel to return to the previous screen without
opening the project.
4. E-Config automatically opens the project:

5. You can now start configuring.
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Showing project information
E-Config shows project information using an hierarchical “tree view” that lets you show or
hide information as required.
To show project information, click the Plus sign
click the Minus sign
Show information

to show (i.e. expand) the information or

to hide (i.e. collapse) the information:
Hide information

The unit name also shows the unit address:

Note
The unit name is a default name for the unit. You can change this name to (e.g. Pump
Station 14).
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E-Config lets you sort the tree view:




By name – that shows the units in alphabetical order of their unit names; or
By address – that shows the units in numerical order of their unit addresses.

To sort the tree view:
1. Open the project.
2. Select View » Sort Tree View » by Name (or by Address).
3. E-Config sorts the tree view:
Sort by name
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Setting project information
E-Config lets you set the following project information:
Field

Description

For more information, see
…

Project name

Lets you set a name to uniquely identify the
project.

Setting the project name on
page 29.

Project location

Lets you set the location on your PC where EConfig will store the project.

Setting the project location on
page 30.

Project password

Lets you set or remove a password to help protect
the configuration file against unauthorized
changes.

Removing the project
password on page 38.

System address

Lets you group modules in a system. Modules
ignore messages from modules not sharing share
their system address to prevent “cross-talk”
between modules in different systems.

Setting the system address on
page 29.

System security code

Lets you set or remove a system security code to
help ensure the messages that your network uses
remain private.

Encrypting messages by
setting a security code on
page 33.

For more information, see the next sections.
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Setting the project name
E-Config uses a project name to uniquely identify your system. Each system can have
multiple units of different types.
To set the project name:
1. Open the project.
2. E-Config shows the project name:

3. Change the project name as required. E-Config shows the new project name:
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Setting the project location
905U-L stores project information in a “Projects” directory with each individual project stored
in a separate directory.
The default project directory is <installation location>\Projects.
For example, C:\Program Files\Eseries\Projects.
If you want to change the project location, you must backup the project and then restore the
project to the new location.
For more information on backing up and restoring projects, see Backing up projects on page
39 and Restoring projects on page 41.
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Setting the system address
E-Config uses a system address to group modules in a system. Modules ignore messages
from modules not sharing share their system address to prevent “cross-talk” between
modules in different systems.
Separate networks with different system addresses can operate independently in the same
area without affecting each other.
The system address can be any number between 1 and 32 767. The actual value of the
system address is not important; however you must use the same system address for all
modules in the same system or they cannot communicate with each other.

Note
You should NOT use a system address of zero.
If you change the system address for an existing project, you must re-program all
modules in the system.

When setting the system address, the 905U-L randomly selects a system address; however
you can change the system address if required.
To set the system address:
1. Open the project.
2. Enter the system address:
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to set the new value or click Cancel Field

to keep the

4. E-Config confirms you want to change the system address:

5. Click OK to change the system address or click Cancel to quit without changing
the system address.
6. E-Config automatically changes the system address.
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Encrypting messages by setting a security code
E-Config lets you set a system security code to help ensure the messages that your network
uses remain private. This provides an additional security layer to protect the system from
malicious access (e.g. hacking).
When security is enabled the 905U-LT uses the security code to encrypt all transmitted radio
messages and the 905U-LR will only receive messages encrypted with the same security
code.

Note
By default, the 905U-L does not encrypt radio messages. You must enable security if
you want to encrypt radio messages.

The 905U-L uses the security code to encrypt radio transmissions using 64-bit encryption.
All modules in the same system must use the same security code to encrypt and decrypt
messages or they cannot communicate with each other. The security code is downloaded to
each module when you download the configuration.

Note
You can download the configuration at any time. E-Config overwrites the old security
code if the new security code is different or the new configuration has no security code.

You can also remove the security code if required. For more information, see Removing the
security code on page 35.
To set the security code:
1. Open the project.
2. Select Enable Security

3. E-Config automatically generates a random 8-character security code for the system.
You can use the random security code generated by E-Config or enter your own code.
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4. If you modify the security code, E-Config prompts you to confirm the code by reentering the code:

Note
The security code can be 1 to 8 characters or numbers and is case-sensitive.
A longer security code is stronger (i.e. offers a higher level of security) than a shorter
security code
To ensure the security code remains confidential, E-Config shows a hash character (i.e.
“#”) for each letter or number entered; E-Config never shows the security code in plain
text.

5. Click Set Field
value.

to set the new value or click Cancel Field

to keep the original

6. Click OK to save the security code for the project.

Note
If you do not enter the same security code when confirming, E-Config shows the
following warning:

Click OK to acknowledge the message and re-enter the security code.

7. E-Config checks you want to use the security code:

8. Click OK to set the security code or click Cancel to quit without setting the security
code.
9. E-Config sets the security code and shows a message indicating the security code is
active:

10. Click OK to acknowledge the message.
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Removing the security code
E-Config lets you set or remove a system security code to help keep the communications of
your system private and to protect the system from malicious access (e.g. hacking). For more
information on setting the security code, see Encrypting messages by setting a security code
on page 33.
To remove the security code:
1. Open the project.
2. Unselect Enable Security:

3. E-Config confirms you want to remove the security code:

4. Click OK to remove the security code or click Cancel to return to the previous screen
without removing the security code.
5. E-Config removes the security code:

905U-L Wireless I/O
Version 1.4

page 35 of 108

ELPRO Technologies

905U-L Wireless I/O Configuration Manual

Securing a project using a password
E-Config lets you set a password (between 6 and 256 characters) to help protect the
configuration file against unauthorized changes.
If you set a password, you need to enter the password each time you enter the project to:





Change - the configuration;
Download - the configuration; or
Upload - the configuration.

Note
If you do not enter the password you can still view the configuration; however you
cannot make changes.
If unauthorised file access is an issue; we recommend you change the password
regularly as well as whenever staff changes.

To secure a project using a password:
1. Open the project.
2. Click Project Password

.

3. E-Config shows the Project Password page:

4. Select Enable Password Protection:
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5. Enter the password (6 to 256 characters) you want to use for the project and then reenter to confirm the password.

Note
The password can be between 6 and 256 characters long and is case-sensitive. You
can enter any ASCII characters (including letters, numbers, other keyboard characters,
etc.).
To ensure the password remains confidential, E-Config shows a hash character (i.e. “#”)
for each letter or number entered; E-Config never shows the password in plain text.

6. Click Set Field
to set the new value or click Cancel Field
value and leave the password entry page.

to keep the original

7. Click OK to save the password for the project.

Note
If you do not enter the same password when confirming, E-Config shows the following
warning:

Click OK to acknowledge the message and re-enter the password.

Note
If you do not click Set Field
message:

to set the password, E-Config shows the following

Click OK to acknowledge the message and leave the password entry page.

8. E-Config sets the password and shows a message indicating the password is active:

9. Click OK to acknowledge the message.
10. Click OK to leave the password entry page.
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Removing the project password
To remove the project password:
1. Open the project.
2. Click Project Password

.

3. E-Config shows the Project page.
4. Unselect Enable Project Password:

5. E-Config checks you want to remove the project password:

6. Click OK to remove the project password or click Cancel to return to the password
entry page without removing the project password.
7. E-Config removes the project password:

8. Click OK to leave the password entry page.
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Backing up projects
E-Config lets you save a project on your PC. You can set the location where you want to save
the project.

Note
E-Config packs the database before saving. The database is then compressed to a
single file using the ZIP file format. You can copy this file to another computer or store it
on removable media.

To backup a project:
1. Open the project.
2. Select File » Backup Project.

Note
If there is no project open, E-Config shows the following error message:

Click OK to acknowledge the message and then open the project you want to save.

3. E-Config automatically packs the database and shows the following message:

4. Click OK to acknowledge the message.
5. E-Config allows you to select the location where you want to save the backup:
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6. Click Save to backup the project or click Cancel to return to the previous screen
without backing up the project.
7. E-Config backs up the project and shows a message indicating the backup was
successful:

8. Click OK to acknowledge the message.
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Restoring projects
E-Config lets you recover a project that has been backed up. This project could be stored on
your PC or on removable media (e.g. USB drive or CD).
To restore a project:
1. Open the project.
2. Select File » Restore Project.
3. E-Config prompts you to enter the location from where you want to restore the project:

4. Select the project you want to restore and click Open to restore the project or click
Cancel to quit without restoring the project. Select the directory where you want to
restore the project to and click OK to restore the project or click Cancel to return to the
previous screen without restoring the project:

5. If the location where you want to restore the project does not exist, E-Config checks
you want to create a new directory:
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6. If the location where you want to restore the project already contains a project, EConfig checks if you want to overwrite the existing project.
7. If the directory does not already exist, E-Config checks you want to create the
directory:

8. Click OK to create the new directory or click Cancel to return to the previous screen
without creating the new directory.
9. E-Config restores the project to the directory specified and opens the for you (any
previous project is closed):

10. You can now work with the project.
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Working with units
E-Config lets you:
If you want to …

Description

For more information, see
…

Create new units

Lets you add new units by creating a new unit,
copying an existing unit.

Creating new units on page
44.

Delete units

Lets you remove a unit from the system.

Deleting units on page 60.

Setting unit
information

Lets you set mandatory information for all units in a
system regardless of the type of unit:

Setting unit information on
page 52.

Load unit addresses

Lets you set the unit address that determines how
the network communicates with the module.

Setting the unit address on
page 54.

Load protocol types

Protocol type is always disabled for the 905U-L.
Note: Only the 905-G and 105-G modules support
protocol types.

Set unit mappings

Mappings let you configure messages to be sent
from one module to another.

Sending data to another
station using mappings on
page 62.

Set unit output reset
times

You can configure outputs to turn off (i.e. reset) if
the output is not sent data for a long time. Output
reset time is the time to wait after receiving data
before resetting the output to a safe state (0mA for
analog, off for digital).

Handling communication
failures by setting output
reset times on page 86.

Set unit sensitivities

Unit sensitivities indicate the change required in an
analogue input for the module to detect a state
change and transmit a new value.

Setting unit sensitivities on
page 70.

Set unit pulsed inputs

Pulsed inputs count the number of pulses.

Counting events by setting
unit pulsed inputs on page
71.

Set unit setpoints

Lets you generate a digital on/off value from the
value of an analog input.

Setting setpoints on page
73.

Set unit debounce

Lets you set the time an input must differ from its
previous value before the module identifies a state
change.

Setting additional unit detail
information on page 81.

Show unit summary

Lets you view and print the user options configured
for the unit.

Showing and printing the
unit summary on page 58.

Show mapping
summary

Lets you view and print the mappings for the unit.

Showing and printing the
unit mappings on page 59.

For more information, see the next sections.
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Creating new units
E-Config lets you:
If you want to …

Description

For more information,
see …

Add a new unit

Lets you add a new unit.

Creating and adding a new
unit to the configuration on
page 45.

Copy an existing unit

Lets you add a new unit by copying an existing unit.

Duplicating a unit on page
47.

Load a new unit

Lets you load a new unit from an already-configured
module.

Reading configuration from
a module (loading a new
unit) on page 49.

For more information, see the next sections.

905U-L Wireless I/O
Version 1.4

page 44 of 108

ELPRO Technologies

905U-L Wireless I/O Configuration Manual

Creating and adding a new unit to the configuration
To create and add a new unit to the configuration:
1. Open the project.
2. Select the Units branch of the navigation tree:

3. Click Add New Unit

or select Unit Options » New Unit.

4. E-Config shows the Select Unit Type page:

5. Select the unit type you want to add.
6. Click OK
to add the new unit or click Cancel
without adding the new unit.

to return to the previous screen

7. E-Config checks whether you want to choose the address of the new unit:

8. Click Yes to choose the address yourself, click No to let E-Config automatically select
the address or click Cancel to return to the previous screen without selecting the
address.
9. If you allow E-Config to automatically select the address it selects the lowest unused
unit address.
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10. If you choose to set the address, E-Config prompts you with a page showing the
addresses already used in the system:

11. Select an unused address and click OK
click Cancel

to assign the address to the new unit or

to return to the previous screen without creating a new unit.

12. E-Config creates the new unit:

13. You can now configure the new unit.
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Duplicating a unit’s configuration (shortcut)
E-Config lets you add a new unit by copying an existing unit. E-Config copies all the
configuration information for the unit. This option is useful for creating a new unit with a
similar configuration to an existing unit.
To copy a unit:
1. Open the project.
2. Select the unit you want to copy.
3. Right click and from the shortcut menu select Copy Unit:

Note
If you have not selected a unit to copy, E-Config shows the following message:

Click OK to acknowledge the message and select the unit you want to copy.

4. E-Config checks whether you want to choose the address of the new unit:

5. Click Yes to choose the address yourself, click No to let E-Config automatically select
the address or click Cancel to return to the previous screen without duplicating the
unit.
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6. If you allow E-Config to automatically select the address, E-Config will choose the
lowest unused unit address. If you choose to set the address, E-Config shows a page
indicating the addresses already used in the system:

7. Select the address and click OK
click Cancel

to assign the address to the duplicated unit or

to return to the previous screen without duplicating the unit.

8. E-Config creates a new unit with identical configuration to the selected unit using the
new unit address:

9. E-Config automatically checks the unit configuration and shows any error messages.
10. You can now configure the new unit
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Reading configuration from a module (loading a new unit)
To load a new unit from an already-configured module:
1. Open the project.
2. Connect the module that you want to load to one of your PC serial ports using the
ELPRO RS-232 serial cable.
3. Select the serial port that has the cable connected by clicking on the Com Port field
and selecting the appropriate port from the list that appears (this step can be skipped if
the correct serial port is already selected):

4. Click Load a New Unit

or select Unit Options » Load into New.

5. E-Config prompts you for the unit type:

6. Select the unit type you want to load.
7. Click OK
to load the new unit or click Cancel
without loading the new unit.
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8. E-Config loads the contents of the connected module and may show one or more of
the following errors:
Error

Description and action
If there is no module connected to the serial
port you have selected or E-Config cannot
communicate with the module the following
message is shown:
Click OK to acknowledge the message and
check the power to the module, the comm
port selected and the serial
cable/connections to try again.
If the module connected to the serial port
has the same unit address as one already
in the system, E-Config will show the
following message if either the unit or the
module does not support secondary
addresses (i.e. either one is not transmit
only):
Click OK to acknowledge the message and
return to the previous screen without
loading the module.
If the module connected to the serial port
has the same unit address as one already
in the system but both the unit and the
module support secondary addresses, EConfig will show the following message:
Click OK to acknowledge the message and
continue loading the module or Cancel to
return to the previous screen without
loading the new unit.
If the module connected to the serial port
has the same secondary address as one
already in the system, E-Config will show
the following message:
Click OK to acknowledge the message. If
you choose to continue loading the module
check that you have the correct module
connected. The new unit will retain the
module’s unit address and will be assigned
the lowest unused secondary address for
that unit address.
If the module connected to the serial port
has a different system address to the one
already assigned to the system, E-Config
will show the following message:
Click OK to continue loading the unit or
Cancel to return to the previous screen
without loading the module configuration.
If you choose to continue you will be asked
whether you want to modify the system
address of the system to match that of the
module you are loading:
Click Yes to change the system address to
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Description and action
match the unit you are loading or No to
keep the existing system address already
being used by other units in the system.
If you choose to change the existing system
address all the existing modules must be
reprogrammed before the update is
complete.
If you choose to keep the existing system
address you must program the unit you are
loading so that it will have the same system
address as the rest of the system.

9. You can now configure the new unit.
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Setting unit information
Every unit in a system has specific information configured for all units regardless of the type
of unit. This information includes:



Unit name – you can use this name to refer to the unit when configuring mappings
from other units.



Unit Address- unique address assigned to the unit. Some module types have two
addresses (e.g. 905U-3 and 905U-4).



Secondary address - for larger systems, the secondary address allows more than one
transmit-only module to share the same unit address. This only applies to 905U-K and
905U-LT modules.



Protocol Type - protocol used by the 905U-G modules only.

E-Config lets you:
If you want to …

Description

For more information,
see …

Set the unit name

Lets you set the unit name to one that is meaningful to
you.

Setting the unit name on
page 53.

Set the unit address

Lets you set the unit address that identifies the unit in
the system

Setting the unit address
on page 54.

Set the secondary
address

Lets you assign multiple transmit-only units to the same
unit address and observe the secondary address
assigned by E-Config

Setting the unit secondary
address on page 57.

For more information, see the next sections.
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Setting the unit name
E-Config lets you set the unit name to a name that is more meaningful to you. For example,
you can initially configure a unit called 105-1#14 and then change the name to Pump station
14.
To set the unit name:
1. Select the unit you want to change.

2. Enter the new unit name

E-Config automatically updates the unit name in the unit information and also in the
unit listing at the side of the page.
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Setting the unit address
E-Config lets you set the unit address used by the system when sending messages to a
module.
A valid unit address for the 905U-L module is between 1 and 95.

Note
You cannot use a unit address of 0.

A network can have up to 95 addresses communicating via radio (i.e. unit addresses 1 to 95).
Other 105-series modules support up to 31 serial modules communicating via RS-485. The
upper unit addresses are reserved for identifying these serial modules (i.e. unit addresses 96
to 127). The 905U-LT can send messages to the RS-485 connected serial modules.
You can map any individual input signal in the network to one or more outputs anywhere in
the system.
The unit address determines the method of communication to a module:




Modules with a unit address between 96 and 127 - communicate by RS-485 only.
Other units with a unit address below 95 - can communicate by radio or RS-485.
The unit determines the communication method based on the unit address of the
destination module. For example, Unit 31 can talk to Unit 97 by RS-485 only, but will
talk to unit 59 by radio only.

Note
105S and 115S units can only communicate via serial communication and must always
have a unit address between 96 and 127.
905U-L units can only communicate via radio and must always have a unit address
between 1 and 95.
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To set the unit address:
1. Select the unit you want to change.
2. E-Config shows the unit address:

3. Select Browse
4. E-Config shows the list of unit addresses and indicates the addresses already in use:
5. Select an unused address and click OK
to set the new address or click Cancel
to return to the previous screen without setting the new address.
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6. E-Config changes the unit address:

7. You can also change the unit name to reflect the new address if required. For more
information, see Setting the unit name on page 53.
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Setting the unit secondary address
The 905U-LT supports a secondary address that lets you re-use the same unit address for
multiple transmit-only units. This is useful if your network has a large number of transmit-only
units.
To re-use the same address:

Note
To use the same address you must have an existing 905U-LT unit.

1. Create a new 905U-LT.
2. E-Config checks if you want to manually set the address:

3. Click Yes to manually set the address. If you click No E-Config will select an unused
address for the new unit, or if you click Cancel the new module will not be created.
4. Select an address already used by a transmit-only unit that you want to reuse and click
OK
to set the address. If you click Cancel
screen without creating a new unit:

E-Config will return to the previous

5. E-Config automatically assigns the secondary unit address to a different number:

6. Click OK to acknowledge the message.
7. You have created a unit with a new secondary address.
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Showing and printing the unit summary
The unit summary lets you print a summary of the information set for the unit.
To show and print the unit summary:
1. Open the project.
2. Select the unit for showing the summary.
3. Click Unit Summary

.

4. E-Config shows the unit summary:

Note
The Unit Summary may span multiple pages. You can use the navigation keys at the top
of the report to move to the first, previous, next or last pages:

5. To print the unit summary, click Print

.

6. E-Config automatically submits the job to the printer.
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Showing and printing the unit mappings
The unit mappings lets you print a summary of the mapping information for the unit.
To show and print the unit summary:
1. Open the project.
2. Select the unit for showing the summary.
3. Click Mapping Summary

.

4. E-Config shows the unit mapping:

5. To print the unit summary, click Print

.

6. E-Config automatically submits the job to the printer.
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Deleting units
Deleting units lets you remove a unit from the system.
To delete a unit:
1. Open the project.
2. Select the unit you want to delete
3. Right click and from the shortcut menu select Delete Unit. You can also click Delete
Unit in the Unit Options panel of the unit screen:

Note
If you do not select a unit to delete, E-Config shows the following message:

Click OK to acknowledge the message and select the unit you want to delete.
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4. E-Config checks you want to delete the unit:

5. Click Yes to delete the unit or click No to return to the previous screen without deleting
the unit.
6. E-Config automatically deletes the unit.
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Transmitter information
This section contains specific information for configuring your 905U-LT unit.

Sending data to another station using mappings
To send data from a transmitter module 905U-LT to another 105 series module you must
configure mappings in the transmitter unit. Mappings let you link inputs at the transmitter unit
to outputs at another 105 series module and lets you configure which inputs are sent to which
outputs. Mappings can be triggered on a change of state (event reporting) or on a timed basis
(periodic update).
E-Config lets you:
Feature

Description

For more information,
see …

Add unit mappings

Lets you add a new mapping to link inputs to outputs:

Adding new mappings on
page 63.

Change unit mappings

Lets you change an existing mapping.

Changing unit mappings
on page 68

Delete unit mappings

Lets you remove an existing mapping.

Deleting unit mappings on
page 69.

For more information, see the next sections.
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ADDING NEW MAPPINGS (905U-LT ONLY)
E-Config lets you add mappings to define how the system shares information. Conceptually a
mapping takes the value of an input and shares it with another module, usually by setting the
state of one of the module outputs. The mapping display shows all inputs (including physical
inputs and internal inputs) for the selected module.
905U-LT transmits messages only; it cannot receive messages and has no communication
failure contingency.
E-Config lets you send multiple input values in a single message to help reduce the number
of transmissions.
You can also:



Invert inputs – if you invert an input, the transmitted message sends the inverse value
of the actual input; and



Reverse analog inputs – the inverse of an analog input reverses the magnitude of
the value (e.g. 4mA becomes 20mA).

Note
Do NOT invert pulsed inputs.

E-Config uses arrows to indicate the communication direction:
Arrow

Description
1-way communication
2-way communication (i.e. re-transmits
message if no acknowledgement received).
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To add a new mapping:
1. Open the project and select the unit where you want to add the mapping.
2. Select Mappings. E-Config shows the mapping list:

3. Click New Mapping
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4. E-Config shows the mappings page that contains information on two tabs:
Tab

Example

Mapping

Advanced

5. Set the required information. For more information, see How to configure a mapping on
page 66.
6. Click OK
to set the mapping or click Cancel
creating a new mapping.

to return to the mapping list without

7. E-Config creates the new mapping and displays the mapping in the mapping list.
8. The module will not use the new mapping until you reconfigure it.
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HOW TO CONFIGURE A MAPPING
Mappings configure when to send specific information to another module and how the data is
sent. You can send input data:




When the input values change (also called “Event reporting”); or
Event reporting and on a timed basis (also called “Timed Update”).

Mappings cause the 905U-LT to transmit messages when any of the inputs used by the
mapping change state. You can also configure your unit to send messages if there are no
state changes for a while.
Feature

Description

Mapping
name

Optional user-defined name for the mapping.

Transmit
count

Number of times to transmit the same message. For example, if you set Transmit count to 1, the
905U-LT transmits the message once, if you set the value to 2, the 905U-LT transmits the message
twice, etc.

NOTE: E-Config only stores the mapping name in the configuration file; the mapping name is not
transferred to the module during configuration. This means that loading a module will not reproduce
any user-defined names assigned to the mappings.

Setting the transmit count to a higher number (up to 8) helps the message arrive at its intended
destination if the radio path is “marginal”. For large systems, excessive transmissions may cause
slow response. ELPRO recommends setting a transmit count of 2 or 3 for good radio paths, and 4 or
5 for poor radio paths.
Delay
Before Tx

Number of seconds to wait after the mapping is triggered before transmitting the message. For
example, if you set Delay Before Tx to 5.0, the 905U-LT waits 5 seconds before transmitting the
message.
Setting a longer Delay Before Tx (up to 127 seconds) helps synchronise closely spaced changes to
different inputs sent in a single message. Once the mapping is triggered, the 905U-LT incorporates
any changes to the state of inputs during the Delay Before Tx period in the message that is sent.

Update
Time

If a “change” trigger does occur not in the Update Time, the 905U-LT triggers the mapping and
transmits the message. This is known as an “Update message”.
Whenever the mapping is triggered (by either a change or an update), the 905U-LT restarts the timer.
For example, if you set Update Time to 0:2:30:00, the 905U-LT sends the message 2.5 hours after
the last time it was sent unless a change of state causes the mapping to be triggered before this time
elapses.

Paralysis
Time

Minimum number of seconds to delay after sending a message before the mapping is re-sent. For
example, if you set Paralysis Time to 300 seconds, the 905U-LT will not transmit a message for 300
seconds after sending the last message sent. If the mapping is triggered during this time, the 905ULT delays transmitting the message until the Paralysis Time has passed. This forces a limit on the
number of transmissions that can occur.

Disable

Lets you enable/disable the Update Timer and the Paralysis Timer.
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From
inputs

This selects the actual input data the 905U-LT will send. The 905U-LT sends data to the output
module in the order listed.
Select the inputs you want to send to the remote module by dragging them from the Available Inputs
box or by double-clicking the relevant inputs. Alternatively you can right click on the inputs in the
Available Inputs list and select Add to list:

Any of the available inputs can be added to the From Inputs box in any order, including the same
input multiple times. You can change the order for sending inputs by clicking and dragging the items
up and down to different locations in the list.
The pulsed inputs are 32-bit values with the top 16 bits in the ‘high’ inputs.
To remove an input from the list, select the input and from the shortcut menu select Delete:

To invert an input, select the input in the From Inputs box. Press Ctrl+I or right click on the input and
select Invert from the list:

To
destination

The 905U-LT will send the information about the inputs in a message to this module when the
mapping is triggered.
NOTE: You can also select Unknown Unit if the unit has not been added to your project yet. In this
case you must enter the actual address of the module in the To Destination field, and the actual
output number into the First Output Address field.

First
Output
Address

The 905U-LT sends the data to the outputs at the destination module starting at this output in the
destination module. The outputs in the destination module are listed in order.

Via
repeaters

Sequence of units for forwarding the message to its final destination.
NOTE: You can either select the units from the dropdown list or enter the unit number.

Note
Some module types only support mappings with one single input. These are the 905U-1,
905U-2, 905U-3 and 905U-4 modules.
If you need to send more than one input to these modules, you must enter multiple
mappings, each with a single input selected.
If you need to use one of these modules as a repeater, you can only send mappings
with a single input selected. If you need to send large amounts of data, you should use a
905U-G module to act as a repeater.
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CHANGING UNIT MAPPINGS
E-Config lets you change an existing mapping.
To change unit mappings:
1. Open the project.
2. Select the unit you want to change:
3. Select Mappings.
4. Select the mapping you want to change and click Edit Mapping

.

5. E-Config shows the mapping information:

6. Change the mapping information as required. For more information, see How to configure
a mapping on page 66.
7. Click OK
mapping.

to change the mapping or click Cancel

to quit without changing the

8. The module will not use the modified mapping until you reconfigure it.
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DELETING UNIT MAPPINGS
E-Config lets you delete an existing mapping.
To delete unit mappings:
1. Open the project.
2. Select the unit you want to change.
3. Select Mappings.
4. Select the mapping(s) you want to delete.

Note
You can also Shift+Click and Ctrl+Click to select multiple mappings.

5. Click Delete

or right click and click Delete or click Del on your keyboard.

6. E-Config confirms you want to delete the selected mapping(s):

7. Click Yes to delete the mappings or click No to return to the previous screen without
deleting the mappings.
8. E-Config automatically deletes the mapping(s) from the mapping list.
9. The module will continue to use the deleted mappings until you reconfigure it.
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Setting unit sensitivities
Unit sensitivities indicate the change required in an analog input for the 905U-LT to detect a
state change and trigger any mapping that includes the input.
If you set the sensitivity to a small value, the mappings using the input will trigger on a small
change of value. If the input is noisy or variable, this can congest the radio channel by
sending multiple spurious messages. You can overcome this situation by increasing the
sensitivity value.
To set unit sensitivities:
1. Open the project.
2. Select the unit you want to change.
3. Select Sensitivities
4. E-Config shows the sensitivities for the unit:

5. Select the sensitivity you want to change and click Edit Sensitivities

.

6. E-Config shows the sensitivity:

7. Set the sensitivity as required and click OK

to set the new value or click Cancel

to return to the sensitivity list without changing the sensitivity.
8. E-Config will write the new sensitivity value to the module when you reconfigure it.
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Counting events by setting unit pulsed inputs
Pulsed inputs let you count the number of transitions occurring on an input or the rate those
transitions occur.
E-Config lets you set:



Pulsed input rate – detects the rate of transitions on an input.

Note
The 905U-LT does not support pulsed input rate.



Pulsed input count – that counts the number of low-to-high transitions occurring on
the input. The 905U-LT lets you set the number of transitions that must occur before a
‘change of state’ occurs and any mappings using the pulse count are triggered.

To set unit pulsed inputs:
1. Open the project.
2. Select the 905U-LT unit you want to change.
3. Select Pulsed Inputs.
4. E-Config shows the Pulsed Inputs page:

5. Select the Count tab (the Rate tab has no entries to select).
6. Double click the Pulsed Input you want to change or select the Pulsed Input and click
Edit
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7. E-Config shows the range of values you can enter:

8. Click OK
to change sensitivity of the pulsed input count or click Cancel
to
return to the pulsed input screen without changing the sensitivity of the pulsed input
count.
9. E-Config will write the new sensitivity value to the module when you reconfigure it.
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Setting setpoints
Setpoints let you generate a discrete setpoint status signal based on the value of an analog
input.
Each setpoint status is associated with two setpoint values - a high threshold value and a low
threshold value.
When the analog level moves above the high setpoint value, the setpoint status turns off.
When the analog level moves below the low setpoint value, the setpoint status turns on. If the
analog input remains between the threshold values, the setpoint retains its previous value
(i.e. does not change state). This provides a measure of hysteresis.

Note
The high setpoint MUST be higher (i.e. greater value) than the low setpoint.

The analog input and the thermocouple input setpoints allow selection between ten different
threshold pairs using the rotary switch on the front panel.
For more information on translating analog signal types, see Appendix A – Tables for
translating different analog signal types on page 104.
E-Config lets you set the following setpoints:
Feature

Description

Analog
setpoint

This setpoint is associated with the 4-20 mA analog input.

Example

One of ten different pairs of (low setpoint, high setpoint) is selected
by the position of the rotary switch on the front panel of the 905U-LT
module. Alternatively the analogue setpoint threshold values can be
set to single values (select the Single tab) independent of the rotary
switch position.
“NO” indicates the switch position for this setpoint setting.
Low SP and High SP are the low and high threshold values.
Units: By changing the Units setting, the values of high and low
thresholds can be displayed in different format.

• Raw - data format used by ELPRO modules for transferring
analog values. 16384 corresponds to 4mA, or 0% reading, and
49152 corresponds to 20mA or 100% reading
• mA –actual milliamp value for a 4-20 mA input.
• % - percentage of full scale. 4mA is 0%; 20mA is 100%.
For more information on the relationship between different analog
units in the 905U-LT, see Appendix A – Tables for translating
different analog signal types on page 104.
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Feature

Description

Thermocouple
setpoint

This setpoint is associated with the thermocouple input and can also
be configured to read millivolt values.

Example

You can select one of ten different low setpoint/high setpoint pairs
by changing the position of the rotary switch on the front panel of
the 905U-LT module. Alternatively you can set the thermocouple
setpoint threshold values to single values independent of the rotary
switch position by selecting the Single tab.
NO indicates the switch position for this setpoint setting.
Low SP and High SP are the low and high threshold values.
You can also show the values of the high and low setpoints in
different formats by setting the Units field to:

• Raw - data format used by ELPRO units for transferring
analog values.
For millivolt measurement, 16384 corresponds to zero millivolts,
or 0% reading; 49152 corresponds to 100 millivolts or 100%
reading
For temperature measurement, 16384 corresponds to the
bottom of the thermocouple range; 49152 corresponds to the top
of the thermocouple range.
• mA –actual milliamp value that would be output if the
thermocouple input was sent to a 4-20 mA output. (Not normally
used for thermocouple input).
• % - percentage of full scale, with minimum value being 0%
and maximum value being 100%.
For more information, see Selecting thermocouple tables on
page 77.
Temperature
setpoint

This setpoint is associated with the module’s internal temperature
measurement.
The setpoint comes on when the module temperature moves below
the low setpoint, and will go off when the module temperature
moves above the high setpoint.

Supply
voltage low

This setpoint is associated with the module’s supply voltage
monitoring.
The setpoint turns on when the supply voltage falls below the low
setpoint, and turns off when the supply voltage moves above the
high setpoint.
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To set setpoints:
1. Open the project.
2. Select the unit you want to change.
3. Select Setpoints.
4. E-Config shows the setpoints:

5. Double click the setpoint you want to change or select the setpoint and click Edit
Setpoint.
6. E-Config shows the setpoint:

7. Set the setpoint threshold values as required
8. Set the new value and click OK to save the setpoint or click Cancel to return to the
setpoint list without changing the setpoint.
9. E-Config writes the new setpoint values to the module when you next configure it.
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Working with thermocouple tables
Thermocouple tables let you measure millivolt signals (-100 to 100 mV) and thermocouple
signals with cold junction compensation.
E-Config supports the following thermocouple linearization tables:





Millivolt Inputs (No linearization);
E, J, K, T tables; or
User-defined tables.

The following diagram shows how thermocouple tables work:

Thermocouple
Linearization
table

Thermocouple /
Millivolt Input

Cold Junction
Compensation on/off

Final Scaling
(Post
Linearization)

Cold Junction
Compensation
Table

On-board Cold
Junction
temperature
measurement

Cold Junction
Temperature

Thermocouple /
Milliamp Input

Enable / Disable
Scaling

Final Value

For more information on signal types, see Appendix A – Tables for translating different analog
signal types on page 104.
E-Config lets you:
If you want to …

Description

For more information,
see …

Select thermocouple
tables

Lets you set the thermocouple tables you want to
use with your unit.

Selecting thermocouple
tables on page 77.

Creating user-defined
thermocouple tables

Lets you create your own customised thermocouple
tables.

Creating user-defined
thermocouple tables on
page 79.

For more information, see the next sections.
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Selecting thermocouple tables
E-Config lets you set the thermocouple that you want to use with your module
The thermocouple measurement system works in conjunction with the on-board cold-junction
temperature measurement to provide cold-junction compensation using the following options:



Enable Cold Junction Compensation - this option is normally selected unless you
are using an external cold junction compensation circuit.



Enable Post Linearization Scaling - lets you to change the range of temperature
reported by the thermocouple system. This is a scale factor applied after linearizing the
thermocouple voltage to a temperature range.
If you are using one of the default thermocouple types, you can set the display format
to “Low and High value”, then enter the temperature you want to correspond to 4mA
(Low) and the temperature that you want to correspond to 20 mA (High).

E-Config automatically configures the Cold Junction and Linearization tables for supported
thermocouple types.
To set thermocouple tables:
1. Open the project.
2. Select the unit you want to change.
3. Select Tables.
4. Select the table required:
Table type

Description

Millivolt input

Automatically disables cold junction
compensation and bypasses the
thermocouple linearization table.

Example

Post linearization scaling is set to
(16384,1.00) to scale the range 0-100 mV to
correspond to an output value of 4-20 mA.

E, J, K, or T
tables

The 905ULT has built-in linearization tables
and cold-junction compensation tables for E,
J, K and T type thermocouples.
Select the desired thermocouple type.
You should normally select Enable
temperature compensation. You should deselect this option if using an external
compensation circuit.
By default, the linearized data is scaled to
correspond to the normal range of the
thermocouple.
To select a different output range, select
Enable Post Linearization Scaling and
enter a different Low and High value.
Low is the temperature that corresponds to a
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Example

4mA output. High is the value that
corresponds to a 20 mA output.
User-defined
tables

For other thermocouple types, you can enter
your own user-defined thermocouple
linearization and cold-junction compensation
tables.
For more information on user-defined
thermocouple tables, see Creating userdefined thermocouple tables on page 79
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Creating user-defined thermocouple tables
E-Config lets you create your own customised thermocouple tables.
You may want to create your own thermocouple tables if the:
•

Configuration software does not support the type of thermocouple you want to use; or

•

You want to match the table to the calibration of a particular thermocouple sensor.

You should normally enter both cold-junction compensation tables and linearization tables for
your thermocouple type.

Note
If you are using an external cold-junction compensation circuit, set all the values in the cold junction
compensation table to 0 and disable cold junction compensation.

To create user-defined thermocouple tables:
1. Open the project.
2. Select the unit you want to change.
3. Select Tables.
4. Select User-defined thermocouple type:

5. You should normally select Enable temperature compensation. You should de-select
this option if you are using an external cold junction compensation circuit.
6. To change the table values, select the value you want to change:
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7. Enter the new value:

Fill the cold-junction table with the millivolt output of the thermocouple corresponding to each
10-degree temperature increment. Your thermocouple documentation should contain this
information.
The Linearization table lets you enter up to 51 data points relating the thermocouple voltage
to the desired output value.
You can enter the desired output value either as a milliamp value (range 0-20 mA) or as a
raw 16-bit unsigned value. Refer to Appendix A – Tables for translating different analog signal
types on page 104 for more information.

Note
You must enter the millivolt input values in ascending order; with the lowest millivolt
value entered into entry 1, and the highest in the last used entry.
Unused entries should be set to “100” millivolts.

8. E-Config writes the new thermocouple tables and settings to the module when you next
configure the module.
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Setting additional unit detail information
This section describes how to set additional unit detail information including:



Sample period and warmup time - the 905U-LT only turns on the analog circuits and
the +24V analog loop power supply when they are actually required. You can reduce
the module power consumption by limiting the amount of time the analog circuitry and
the +24V analog loop supply is enabled.
Sample period determines how often the module checks an analog signal. Warmup
time determines how long the analog circuits are powered up before performing the
sample. The analogue circuitry is powered all the time if the warmup period for any
analog input is set to a value longer than the sampling period.
By setting the sample time as long as possible, and setting the warmup time as short
as necessary to power the external conditioning circuitry, the module power
consumption can be reduced; and



Debounce time - the amount of time an input needs to have differed from its previous
value before it is recognised as having changed. This helps with noisy signals.
Inputs subject to a high level of noise can cause the module to transmit multiple
messages due to random changes to the input level.
By setting the debounce time to a larger value, the signal needs to change by the
configured sensitivity for some time before a change is registered and a new message
is sent.

E-Config lets you set the following options:
Feature

Description

Thermocouple debounce

For analog signals (e.g. thermocouple, analog
4-20 mA, and module temperature), debounce
time is the product of the number of samples
and the sample period. The signal must differ
from the previous value by the sensitivity value
for this duration to register a ‘change of state’.

Example

This means that changing the analog sample
time will also change the debounce time. For
analog signals a value of 0 or 1 generates the
quickest response, and 255 the slowest
response.
Thermocouple sample
period

This sets the period between samples of the
thermocouple input.
A smaller value will cause mappings using this
input to be triggered more frequently (i.e.
quicker response).
A larger value will cause mappings using this
input to be triggered less frequently (i.e. less
power consumption).
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Feature

Description

Thermocouple warm up
time

The amount of time the analog circuits are
turned on before sampling the thermocouple
input.

Example

For normal thermocouples, these can be set to
the minimum value (i.e. 0.08 seconds).
If using an external (millivolt) device powered
from the +24V supply that requires a longer
period to settle, you may need to set this value
to allow the external device to settle.

Unit temp sample period

The time between samples of the internal
temperature sensor.
The module temperature (Cold junction
temperature) is sampled every time the
thermocouple input is sampled. You will only
need to set this field if you want to sample the
temperature more often than you sample the
thermocouple, including when you are not
using a thermocouple.

Unit temp warm up time

The amount of time the analog circuits are
turned on before sampling the internal
temperature sensor.
You should always set this value set to the
minimum value (0.08 seconds).

Supply voltage sample
period

905U-L Wireless I/O
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Feature

Description

Ain1 debounce

The debounce time is the product of the
number of samples and the sample period.
The signal must differ from the previous value
by the sensitivity value for this duration to
register a ‘change of state’.

Example

This means that changing the analog sample
time will also change the debounce time. For
analog signals, a value of 0 or 1 generates the
quickest response; 255 generates the slowest
response.
Ain1 sample period

Sets the period between samples of the
thermocouple input.
A smaller value will cause mappings using this
input to be triggered more frequently (i.e.
quicker response).
A larger value will cause mappings using this
input to be triggered less frequently (less
power consumption).

Ain1 warm up time

The amount of time the analog circuits are
powered up before sampling the analog input.

Din1 Debounce

The amount of time the first digital input must
stay in a changed state before it registers as a
change of state.
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Feature

Description

Din2 Debounce

The amount of time the second digital input
must stay in a changed state before it registers
as a change of state.

Example

To set the additional unit detail information:
1. Open the project
2. Select the unit you want to change.
3. Select Unit Details.
4. E-Config shows the available unit details including their current values:

5. Double click the setting you want to change or select the setting and click Edit
Parameter
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6. E-Config shows the relevant setting page showing the range of allowable values:

7. Enter the setting information and click OK

to change the parameter or click Cancel

to return to the detail list without changing the parameter.
8. E-Config will write the unit details to the module the next time you configure the module.

905U-L Wireless I/O
Version 1.4

page 85 of 108

ELPRO Technologies

905U-L Wireless I/O Configuration Manual

905U-LR Receiver information
This section contains specific information for configuring your 905U-LR unit.

Handling communication failures by setting output reset
times
Unit output reset times allow you to configure the outputs to turn off if they do not receive an
update message within a certain time.
The output is reset to a zero value if it does not receive an update message within the
configured time. The output is turned off for discrete outputs. For analog outputs, the output is
actually set to -4mA internally, however the lowest current at the output is 0mA
As well as resetting the output, the front panel LED for the output flashes quickly to indicate
communication failure.
If any output is reset because of an output reset timeout, the global communication fail status
output is also activated.

Note
Setting the output reset time to zero is the same as disabling the output reset. The
905U-LR will retain the current output value indefinitely although no messages are
received from the transmitting unit when the output reset is disabled.

To set unit output reset times:
1. Open the project.
2. Select the unit you want to change.
3. Select Output Reset Times.
4. Double click the time you want to change or select the time and click Edit Update
Time.

Note
You can also Shift+Click and Ctrl+Click to select multiple times before you click Edit
Update Time. This allows you to set several timers to the same value quickly. For
example:

5. E-Config will write the new output reset times to the module the next time you
configure the module.
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Printing
E-Config lets you view a summary of your system information and optionally print the
information.
If you want to …

Description

For more information,
see …

Set your printer
information

Lets you specify the printer and settings you want to
use for printing information.

Setting printer information
on page 87.

Show unit summary

Lets you view and print the user options configured
for the unit.

Showing and printing the
unit summary on page
58.

Show mapping summary

Lets you view and print the mappings for the unit.

Showing and printing the
unit mapping on page 59.

For more information, see the next sections.

Setting printer information
Printer information lets you specify the printer and settings you want to use for printing
information (mapping summary and unit summary.).
To set printer information:
1. Open the project.
2. Select File » Printer Setup.
3. E-Config shows the Print Setup page:

4. Select the required options and click OK to save the printer settings or click Cancel to
quit without saving the printer settings.
5. E-Config uses the settings the next time you print information.
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Utilities
Utilities provide one-step access to help speed up common tasks.
E-Config lets you:
If you want to …

Description

For more information,
see …

Show address mapping

Lets you see the addresses allocated to units.

Showing the address
mapping on page 89.

Compile the system

Lets you check your system configuration, report any
errors and generate configuration files for each unit.

Compiling the system on
page 90.

Pack the database

Lets you compress the database so it takes up less
space on your PC.

Packing/compressing the
database on page 92.

Load configuration
information in a unit

Lets you transfer the configuration information to a
unit.

Loading configuration
information into a unit on
page 93.

For more information, see the next sections.
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Showing the address mapping
E-Config lets you see the addresses allocated to units.
This summarises the addresses of each module in a single screen. To change the address of
a module, refer to Setting the unit address on page 54.
To show the address mapping:
1. Open the project.
2. Select Utilities » Address Map.
3. E-Config shows the list of unit addresses and indicating the addresses in use:
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Compiling the system
After configuring the modules, you can check for errors by compiling the system.

Note
The system is also compiled before any data is programmed to any of the modules. It is
not necessary to compile the system before configuring modules.

Compiling the system:





Checks - your system configuration;
Reports - any errors; and
Generates - configuration files for each unit.

After compiling the system, you need to upload the configuration files to the units. For more
information, see Loading configuration information into a unit on page 93.
To compile the system:
1. Open the project.
2. Select Utilities » Compile System.
3. E-Config shows the System Compile page:

4. Click Compile
the system.
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5. E-Config compiles the system and shows any errors or warnings:

Note
You must fix any errors or warnings before using your system.

6. Click Close to close the System Compile page.
7. You can now upload the configuration file to the units. For more information, see
Programming the on page 96.
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Packing/compressing the database
E-Config lets you pack (i.e. compress) the database so it takes up less space on your PC.
To pack the database:
1. Open the project.
2. Select Utilities » Database Utilities » Pack all Databases.
3. E-Config packs all databases and shows an information message indicating the pack
completed successfully:

4. Click OK to acknowledge the message.
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Loading configuration information into a unit
After compiling the system, you need to transfer the configuration information to a unit.
The basic steps for transferring the configuration information to the unit are:
Step

Description

For more information,
see …

1. Connect the unit to the
PC

Lets you connect the unit to your PC using an
RS-232 serial port so you can transfer configuration
information between your PC and the unit.

Connecting the unit to the
PC on page 94.

2. Set the serial port

Lets you set the serial port used when transferring
information to the unit.

Setting the serial port on
page 95.

3. Programming the unit

Lets you load the configuration information from the
PC to the unit.

Programming the on
page 96.

(optionally) Transfer the
configuration
information

Lets you transfer the configuration information from
the unit to the PC.

Transferring information
from the module the PC
on page 98.

For more information, see the next sections.

905U-L Wireless I/O
Version 1.4

page 93 of 108

ELPRO Technologies

905U-L Wireless I/O Configuration Manual

Connecting the unit to the PC
You can connect the 905U-L to an RS-232 serial ports on your PC using an ELPRO serial
cable. This allows you to transfer configuration information between your PC and the module.
If you do not have a serial cable, you can make your own. For more information on cable
connection details, see Appendix B on page 105.
To connect the unit to the PC:
1. Connect the DB9 end of the serial cable to the RS-232 serial port of your computer.

Note
If your computer does not have any RS-232 serial ports but has a USB port, you can
purchase a USB to RS-232 converter to provide the serial interface for configuring the
module

2. Connect the RJ-45 end of the serial cable to the configuration port on the module.
3. Use E-Config to select the serial port on your PC where the cable is plugged in.

Note
The unit lights the LED marked PG on the front panel when your PC is communicating
with the module.

4. You are now ready to configure your module using E-Config.
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Setting the serial port
E-Config transfers configuration information between your PC and the 905U-L using serial
ports.
You must set the serial port to use for transferring the configuration information. This is the
serial port that has the configuration cable connected to the module you are programming.
To set the serial port:
1. Open the project.
2. Select Utilities » Serial Port Setup.
3. Select the serial port you want to use for configuring the unit (e.g. Com 1):

4. E-Config marks the serial port with a tick and uses the serial port the next time you
transfer configuration information between your PC and a module. The selected serial
port is also displayed in the Comm Port field at the bottom left of the E-Config window.
5. You can now transfer configuration information between your PC and the module. For
more information, see the next section.
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Programming the module by transferring information from the PC to
the module
E-Config transfers the configuration information between the module and your PC using a
serial port.

Note
You must set the serial port before loading the configuration. For more information, see
Setting the serial port on page 95.

To program the unit (i.e. write the information form the PC to the module):
1. Open the project.
2. In the tree view, select the unit you want to program.
3. Ensure the module is powered on and the serial cable connected
4. Click Program Unit

.

5. E-Config checks you want to write the configuration information to the module:

6. Click Yes to write the configuration information to the module or click No to return to the
previous screen without writing the configuration information.

Note
If the system address of the module you are programming does not match the address
of the configuration that you are sending, the following warning is displayed:

This helps ensure you program the correct module.
Check the module you are programming should be added to your system. If this is the
correct module, click OK to continue configuring the module. If you have connected to
the wrong module, click Cancel to return to the previous screen and connect the correct
module and repeat the programming operation.
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Note
If the unit address of the module you are programming does not match the address of
the configuration that you are sending, E-Config shows the following warning:

This helps ensure that you program the correct module.
Check the module that you are programming should have its unit address changed. If
this is the correct module, click OK. If you have connected to the wrong module, click
Cancel to return to the previous screen and connect to the correct module and repeat
the programming operation.

7. E-Config writes the configuration information to the module.
8. Once configuration is complete, you should remove power and re-start the module to
enable the new configuration.

Note
If you are programming a module with manually-set analog calibration, and that module
has been set to factory configuration, E-Config lets you select between using the factory
analog calibration or retaining the manual analog calibration.

If the manual analog calibration contains values you want to use, click No to continue
using the manual calibration; otherwise click Yes to reload the factory calibrations or
click Cancel to return to the previous screen without configuring the module.
If you click Yes the manual analog calibration values will be overwritten and cannot be
recovered.
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Transferring information from the module the PC
E-Config transfers the configuration information between your PC and the module using a
serial port.

Note
You must set the serial port before transferring the configuration. For more information,
see Setting the serial port on page 95.

To load the configuration information (i.e. transfer the information from the module to the
PC):
1. Open the project.
2. Select the unit you want to load.
3. Click Load Unit

.

4. E-Config checks you want to read the configuration from the module:

5. Click Yes to read the configuration from the module or click No to quit without loading.

Note
If the address of the module you are loading from does not match the address of the unit
configuration you are reading to, E-Config shows the following warning.

This helps ensure that you program the correct module.
Check that the module that you are loading is correct. If this is the correct module, click
OK to continue configuring the module. If you have connected to the wrong module,
click Cancel to return to the previous screen so that you can connect the correct module
and repeat the loading operation.
If you click OK the configuration of the module is loaded into the unit configuration.
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6. E-Config checks the unit’s current configuration to determine if the user configuration is
valid. If the user configuration is valid and the module is currently configured to use its
factory configuration, E-Config shows the following message to let you select the
configuration to load:

7. Click Yes to factory configuration or click No to select previously stored (i.e. inactive) user
configuration. You can also click Cancel to return to the previous screen without loading
either configuration from the module.
8.

E-Config checks the unit address of 905U-LT modules and shows a warning indicating
the new unit will be created with a secondary unit address as it has the same address as
another 905U-LT module:

9. Click OK to continue or click Cancel to return to the previous screen without loading the
information.
10. If you load from a module with an address already used by another unit in the
configuration, E-Config shows a message indicates the problem:

11. Click OK to acknowledge the error and re-check the unit address.
12. E-Config loads the information and shows a message indicating the load completed
successfully:

13. Click OK to acknowledge the message.
14. You can now work with the unit configuration.
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Troubleshooting
905U-L modules have a diagnostic tool that lets you monitor radio communications to help
you troubleshoot (i.e. fix) problems with your unit. The diagnostic tool checks communications
between the unit and your PC.




On the 905U-LT - you can read the status of the inputs.
On the 905U-LR - you can monitor the radio communications.

E-Config lets you:
Task

Description

For more information,
see …

Monitor radio
communications

Lets you monitor radio communications on a 905U-LR.

Monitoring radio
communications on a
905U-LR on page 101.

Check input statuses

Lets you check input statuses on a 905U-LT.

Checking input statuses
on a 905U-LT on page
103.

For more information, see the next sections.
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Monitoring radio communications on a 905U-LR
To monitor radio communications on a 905U-LR:
1. Select the unit you want to troubleshoot.
2. Click Diagnostics

.

3. E-Config starts the diagnostic tool:

4. Click Start Comms.
5. The display shows the radio messages received. Messages starting with RX indicate a
received message, E-Config also shows the RSSI (radio signal strength indication) in
dBm at the end of each received message.
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6. To view additional information about a message, select the message line with the mouse.
E-Config shows additional information about the message at the bottom of the screen
including the system address, RSSI and CRC (i.e. error-check) status.
The “text box” in the bottom middle of the screen decodes the message to display the I/O
channel and value.

Note
To completely decode the message, you must open the same configuration project
corresponding to the system being monitored.

You can also display the register values as:





Decimal – by selecting Dec.
Digital – by selecting Dig. E-Config displays the value as a 0 or 1 digital value (1 if the
16-bit value is greater than 50% - i.e. the most significant bit is 1).
Analog – by selecting Anlg. E-Config displays the value as a 4-20mA range.

Note
To stop decoding “comms logging”, click Stop Comms.

Other options allow data to be logged to a file, so that the data can be reviewed at a
later time (Open Log File).

Note
Debug I/O is not used on the 905U-L modules.

905U-L Wireless I/O
Version 1.4

page 102 of 108

ELPRO Technologies

905U-L Wireless I/O Configuration Manual

Checking input statuses on a 905U-LT
To check the status of inputs on a 905U-LT:
1. Navigate to the Unit page for the unit you want to check.
2. Click Read Inputs.
3. E-Config shows a page indicating the status of all inputs to the module:

4. Click Update to read the status of the inputs from the module.
5. For analog values (i.e.. 4-20 mA analog, Thermocouple, Temperature and Battery
Voltage), you can select the units for displaying the data:




Raw – shows the value as a decimal number;



mA – displays the number of milliamps that would be output if the data was sent to an
Analog output on an ELPRO 105 module; and



% – displays the percentage of the nominal full scale range.

Hex – shows the value as a hexadecimal number, both in the internal representation of
the module;

For more information on translating between different analog signal types, Appendix A
– Tables for translating different analog signal types on page 104.
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Appendix A – Tables for translating different analog
signal types
Raw value

4-20mA

Supply
voltage

Module
Temp

Millivolt

0-100%

Thermocouple
E

J

K

T

0

-

-

-

-

-

-

-

-

2048

-

-

-

-

-

-

-

-

4096

-

-

-

-

-

-

-

-

6144

-

-

-

-

-

-

-

-

8192

0

-

-

-

-

-

-

-

10240

1

-

-

-

-

-

-

-

12288

2

-

-12.5

-

-

-

-

-

14336

3

-

-6.25

-

-

-

-

-

16384

4

0

-40°C

0.00

0.00

-200.00

-200.00

-200.00

-200.00

18432

5

2.5

-30°C

6.25

6.25

-125.00

-112.50

-101.75

-162.50

20480

6

5.0

-20°C

12.50

12.50

-50.00

-25.00

-3.50

-125.00

22528

7

7.5

-10°C

18.75

18.75

25.00

62.50

94.75

-87.50

24576

8

10.0

0°C

25.00

25.00

100.00

150.00

193.00

-50.00

26624

9

12.5

10°C

31.25

31.25

175.00

237.50

291.25

-12.50

28672

10

15.0

20°C

37.50

37.50

250.00

325.00

389.50

25.00

30720

11

17.5

30°C

43.75

43.75

325.00

412.50

487.75

62.50

32768

12

20.0

40°C

50.00

50.00

400.00

500.00

586.00

100.00

34816

13

22.5

50°C

56.25

56.25

475.00

587.50

684.25

137.50

36864

14

25.0

60°C

62.50

62.50

550.00

675.00

782.50

175.00

38912

15

27.5

70°C

68.75

68.75

625.00

762.50

880.75

212.50

40960

16

30.0

80°C

75.00

75.00

700.00

850.00

979.00

250.00

43008

17

32.5

-

81.25

81.25

775.00

937.50

1077.25

287.50

45056

18

35.0

-

87.50

87.50

850.00

1025.00

1175.50

325.00

47104

19

37.5

-

93.75

93.75

925.00

1112.50

1273.75

362.50

49152

20

40.0

-

100.00

100.00

1000.00

1200.00

1372.00

400.00

51200

21

-

-

-

-

-

-

-

-

53248

22

-

-

-

-

-

-

-

-

55296

23

-

-

-

-

-

-

-

-

57344

24

-

-

-

-

-

-

-

-

59392

-

-

-

-

-

-

-

-

-

61440

-

-

-

-

-

-

-

-

-

63488

-

-

-

-

-

-

-

-

-

65536

-

-

-

-

-

-

-

-

-
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Appendix B – Configuration cable information
You can connect the 905U-L to an RS-232 serial port on your PC using an ELPRO serial
cable to transfer configuration information between your PC and the module.
If you do not have a serial cable, you can make your own using the following Pin numbering:

The following table shows the required connections for the 905U-L configuration cable:
RJ-45

Signal name

Abbreviation

DB9

3

Data Terminal Ready

DTR

4

4

Signal Common

GND

5

5

Receive Data (from 905U-L)

RXD

2

6

Transmit Data (to 095U-L)

TXD

3
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Glossary
This document uses the following terms:
Term

Meaning

Analog signal

Analog signals are continuously variable signals. The 905U-L supports analog
signals in the range 0-20 milli-amps

Cold junction temperature
compensation

When using thermocouples, the module compensates for the reading errors
caused by the temperature of the connection between the thermocouple wires
and the module terminal strip.

Debounce Delay

Number of seconds that a signal must be changed to be recognised as
changed.

Discrete signal

Discrete signals are either active (on) or inactive (off).

Mapping

Configuration item that lets you link inputs at one module to outputs at another
module. Mappings are triggered either by a change in some of the input data
that they send, or by a timer to send an update if the data hasn’t changed.

Module

The actual remote device hardware being configured.

Output reset time

If an output doesn’t have any data sent to it, it can be configured to turn off
(reset). Output reset time is the time to wait after receiving data before
resetting the output to a safe state (0mA for analog, off for digital).

Paralysis

Minimum number of seconds after a mapping is transmitted that it can be
transmitted as a second event if triggered.

Post linearization scaling

Lets you to change the range of temperature reported by the thermocouple
system. This is a scale factor applied after linearizing the thermocouple
voltage to a temperature range.

Pulsed input

Used to count the number of times an event has occurred. Pulsed inputs are
attached to a discrete input, and count the number of times the input has
switched from off to on.

Repeater

A module that receives a message and passes the message to another
module.

Sample time

Determines how often the module checks an analog signal.

Sensitivities

Unit sensitivities indicate the change required in an input for E-Config to detect
a state change and transmit a new value.

Setpoint

Setpoints let you generate a discrete signal based on the value of an analog
input.
Each setpoint is associated with two different values - a high threshold value
and a low threshold value. When the analog input moves below the low
threshold value the set point turns off. When the analog input moves above the
high threshold value the setpoint turns on. When the analog level is between
the high and low threshold values, it does not change.

Thermocouple

Thermocouples measure temperature by using the seebeck effect that occurs
at the junction of dissimilar metals.

Thermocouple linearzation
table

Thermocouple tables translate the millivolt signal from a thermocouple to an
actual temperature measurement. The 905U-L provides built-in support for E,
J, K and T type thermocouples, and support for other thermocouple types
through user compensation tables.

Unit

Configuration of a particular device (module) stored inside the configuration
software

Warm up time

Determines how long the analog circuits are powered up before performing the
sample.
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